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The PAWS Environment 
 

Personalized 
Access to Web 
Services 

PAWS is the acronym for Personalized Access to Web Services, a 
customizable web environment at the U of S.  
 
PAWS hosts a variety of web-based application tools that provide role-based 
access to a broad and comprehensive range of information. This service is 
available to students, faculty, staff, alumni and other members of the 
University community.  
 
PAWS is personalized to you. When you log in, you will see a set number of 
tabs with predefined channels. The displayed information and services will be 
related to your specific role(s) at the University. You may then customize this 
view by subscribing to other areas of interest. 
 

 
 

   

PAWS Navigation Bar 

PAWS Tabs 

PAWS Channels 
 
 
 
 
 
 



PAWS Intermediate: Customization, Advanced E-mail & Calendaring 

2  University of Saskatchewan Training Services 

Personalizing PAWS 
 

Customizing Content Layout 

 Customization of the PAWS environment is now carried out through a number 
of intuitive quick click or drag and drop procedures. All customization begins 
with the creation and modification of organizational units referred to as tabs.  
 
A tab may then be divided into related but separate channels (units) of detail, 
including website accessibility. 
 

 
Adding a Tab To add a new tab: 
  

Step Action 
1 From the PAWS window, click the Add a Tab link (icon) located to 

the right of the default system tab display. 
 

An empty tab name box appears along with the Add tab and Cancel 
buttons: 

 
2 Type the name for the new tab and click Add tab. 

 
Note: Click Cancel to abort the new tab creation. 

The new tab appears to the right of the existing tabs: 

 
 
Adding Content 
to a Tab 

To add content to a tab: 

Step Action 
1 Click on the tab. 

The new tab page displays two options for creating tab content: 

 
2 Select the standard or framed website tab options. 

Continued on the next page 
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Personalizing PAWS 
 

Customizing Content Layout, Continued 
Creating a 
Standard Tab 

To create a standard tab: 

Step Action 
1 Click on the Add stuff to this tab link (left side). 

 
The All channels pane appears: 

 
2 Add the desired channel(s). 

 
Creating a Web 
Tab 

To create a website tab: 

Step Action 
1 In the Create a framed website tab option area (right side), click in the 

URL textbox; either type or paste in the desired website address and 
click Create. 

 
The website content appears in the tab window: 

 
 

Continued on the next page 
  

URL textbox 
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Personalizing PAWS 
 

Customizing Content Layout, Continued 
Repositioning a 
Tab 

To rearrange the display of tabs: 

Step Action 
1 From the PAWS window, click and drag any tab to another location. 

The tab becomes semi transparent during the drag procedure. 

 
Note: Only the Home tab can not be moved. 

 
Renaming a Tab To rename a tab:  

Step Action 
1 From the PAWS window, click on a tab to make it active. 

Two symbols, an arrow and an x are displayed beside the tab. 

 
2 Click on the arrow beside the Tab name. 
3 Type the desired name in the Change tab name text box: 

 
Note: System or default tab names may not be changed. 

 
Deleting a Tab To delete a tab:  

Step Action 
1 From the PAWS window, click any tab to make it active. 
2 Click on the x beside the Tab name. 

A cancellation prompt is displayed: 

 
3 Click OK to confirm deletion of the tab. 

Note: If a default tab is deleted, you must send a request to the 
Help Desk to reset the layout. 

 

Continued on the next page 
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Personalizing PAWS, Continued 
 

Customizing Content Layout, Continued 
 
Restructuring 
Tab Content 

To restructure columnar layout for an entire tab: 

Step Action 
1 From the PAWS window, click on a tab to make it active. 
2 Click the arrow beside the tab name. 

The tab’s Columnar layout options appear: 

 
Note: The current format selection is dark green. 

3 Click the icon representing the desired columnar structure. 
Note: All tab (except the default system tab formats are changed 
accordingly. 

Continued on the next page 
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Personalizing PAWS 
 

Customizing Content Layout, Continued 
Adding a 
Channel 

Channels are topical, at-a-glance, information and links provided by the 
U of S. A channel can be added to any tab and may be positioned according to 
the tab’s columnar format.  

 To add a channel:  
Step Action 

1 From the PAWS window, with the desired tab selected, click on the + 
Add stuff link (top right). 

 
The All channels pane appears: 

 
2 Click on the Page navigation arrow  

or  
Click on a folder (to the left), to display more channels. 

3 Drag the desired channel to the tab content area. 
 
Repositioning a 
Channel 

To reposition a channel in a tab: 

Step Action 
1 From the PAWS window, click the title bar of any channel and drag to 

another location. 

 
 

Continued on the next page 
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Personalizing PAWS, Continued 
 

Customizing Content Layout, Continued 
 
Deleting a 
Channel 

To remove a channel from view: 

Step Action 
1 On the channel title bar, click on the x (right corner). 

The deletion prompt is displayed: 

 
2 Click OK to confirm the deletion. 

Note:  
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Advanced E-mail Management 
 

Working with the Address Book 

 The Address Book allows you to maintain information about frequent contacts. 
It is located in the E-mail application component of PAWS. 

Displaying the 
Address Book 

To view the address book: 

Step Action 
1 From the PAWS navigation bar, click the E-mail icon. 

 
2 From the E-mail application window, click on the Address Book tab. 

 
The Contact List page appears: 

 

Step Action 
1 From the E-mail Options button bar, click New Contact. 

 
 

Continued on the next page 
  

Adding a 
Contact 

To add a contact: 
 

E-mail Options button bar 



  PAWS Intermediate: Customization, Advanced E-mail & Calendaring 

University of Saskatchewan Training Services  9 

Advanced E-mail Management 
 

Working with the Address Book, Continued 
 The Add Contact form dialogue appears: 

 
2 Enter all relevant or known information into the form and click Ok. 

The contact is added to your contact list. 
 
Editing Contact 
Information 

To edit a contact: 

Step Action 
1 From the Contact List page, in the Display Name column, click the 

desired contact name. 

 
The contact form dialogue is displayed. 

2 Make the required changes and click Ok. 

Continued on the next page 
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Advanced E-mail Management 
 

Working with the Address Book, Continued 
Deleting a 
Contact 

To delete a contact: 

Step Action 
1 From the Contact List page, click the checkbox to the left of the 

contact to be deleted. 

 
2 Click the Delete link (icon) and click Ok to confirm the deletion. 

 
Creating a 
Contact Group 

Contacts can be organized into groups for quick distribution of messages to 
multiple individuals interested in the same information. 

 To create a contact group:  
Step Action 

1 From the Contact List page, on the E-mail Options button bar, click the 
New Group button. 

 
The Create Group dialogue appears: 

 
2 Type a Group Name. 

Note: Spaces are allowed. 
3 Select contacts from the All Contacts list on the left. 

Note: Hold down the CTRL key when selecting multiple contacts. 
4 Click the  button to add selected contacts to the New Group 

Contents area. 

Continued on the next page 
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Advanced E-mail Management 
 

Working with the Address Book, Continued 
5 Click the Ok button to save the group. 

The new address book appears as the current View, and all members of 
the group are displayed: 

 
 
Note: The View: list box default is All Contacts. 

 
Editing a 
Contact Group 

Contact groups may be edited as participants come and go. 

 To edit a contact group:  
Step Action 

1 From the current address book display, click the associated checkbox 
to select the desired group. 

2 Click the Edit Group button. 

 
3 Select, move and/or delete individuals from the New Group Contents 

area. 
 
E-mailing a 
Group 

To send an e-mail to a contact group: 

Step Action 
1 From the Contact List page display, click the associated group 

checkbox to select the desired group. 
2 From the E-mail Options button bar, click the E-mail Group button. 

 
The Compose E-mail dialogue opens displaying the selected recipient 
group in the To: text box. 

3 Compose and send the message. 

A confirmation screen displays the list of individual contacts who are 
receiving the message. 

 

Continued on the next page 
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Advanced E-mail Management 
 

Customizing the E-mail Environment 

E-mail Options PAWS E-mail is configurable in a variety of ways through the Options tab. 
This section identifies some customizations that can make e-mail processing 
more efficient. 
 

 
 
Configuring 
Address Book 
Preferences 

To set Address Book Preferences: 

Step Action 
1 From the E-mail window, click the Options tab. 
2 From the E-mail Options page, click the Address Book Preferences 

link. 

The Address Book Preferences dialogue appears: 

 

3 Specify the desired preferences and click Ok to save and exit. 
 
 

Continued on the next page 
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Advanced E-mail Management 
 

Customizing the E-mail Environment, Continued 
Blocking an 
Address 

To block receipt of unwanted (unsolicited) e-mail from specific addresses: 

Step Action 
1 From the E-mail window, click on the Options tab. 
2 From the E-mail Options page, click on the Block Addresses link. 

The Block Addresses dialogue appears: 

 
3 Type the e-mail address in the Address to be Blocked text box. 
4 Click Block Address. 

The address appears in the Blocked Addresses display area. 
5 To discontinue blocking an address, in the Blocked Addresses display 

area, select the desired address and click Remove. 
6 Click Ok to save and exit. 

 
Changing 
Display Settings 

To change display settings: 

Step Action 
1 From the E-mail window, click on the Options tab. 
2 From the E-mail Options page, click the Display Settings link. 

The Display Settings dialogue appears: 

 
3 Make the desired adjustments to the display settings and click OK.  

 

Continued on the next page 
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Advanced E-mail Management 
 

Customizing the E-mail Environment, Continued 
Applying a 
Message Filter 

Message filters can automatically route messages to specific folders. 

To apply a message filter: 
Step Action 

1 From the E-mail window, click the Options tab. 
2 From the E-mail Options page, click the Filters link. 

The Filters instruction dialogue appears: 

 
3 Click Create Filter. 

 
The Create/Edit Filter dialogue appears: 

 
4 Designate filter specifics by selecting a filter criteria:  

 
and entering an e-mail addresses beside the desired filter categories: 
From header: incoming from a specific e-mail address 
To/CC header: addressed or cc’d to a specific email address 
Subject header: based on subject line content 

Continued on the next page 
  

Filter Criteria List Box 
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Advanced E-mail Management 
 

Customizing the E-mail Environment, Continued 
5 Click Choose Folder. 

Your current PAWS E-mail folder structure appears: 

 
6 Select the destination folder for the filtered messages and click Ok. 
7 Click Ok to verify and save the filter. 
8 Click Apply Filters Now to apply the new rule to existing messages; 

or 
click the Enabled checkbox to activate/deactivate a single filter and 
click OK. 

 
 
Setting a 
Message 
Preference 

To set message preferences: 

Step Action 
1 From the E-mail application window, click on the Options tab. 
2 From the E-mail Options page, click the Message Preferences link. 

The Message Preferences dialogue appears: 

 
3 Select the desired preferences and click OK. 

Continued on the next page 
  



PAWS Intermediate: Customization, Advanced E-mail & Calendaring 

16  University of Saskatchewan Training Services 

Advanced E-mail Management 
 

Customizing the E-mail Environment, Continued 
Creating/ 
Applying a 
Signature 

Signatures are used to automatically add common closing or administrative 
detail to e-mails. 

 To create and apply a Signature:  
Step Action 

1 From the E-mail application window, click the Options tab. 
2 From the E-mail Options page, click the Signature link. 

The Signature dialogue appears: 

 
3 Type your signature information in the text box area and click on the 

Add Signature to all messages by default check box. 
4 Click OK to save the signature. 
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Advanced Calendar Management 
 

Setting the Calendar View 

 The PAWS Calendar application allows access to course, group and personal 
calendars. Course calendars containing pertinent scheduling information are 
displayed automatically to those enrolled in a class. Membership in an on-line 
group also results in the automatic display of the associated Group Studio 
calendar. In addition, personal calendars may be created and shared with 
others.  
 
This section describes typical scheduling activities such as recording events, 
tasks and sharing your calendar with others. 

 
Viewing Your 
PAWS Calendar 

To view your PAWS calendar: 

Step Action 
1 From the PAWS navigation bar, click the Calendar icon: 

 
Your default calendar application window appears in the default Day 
view: 

 
 

Continued on the next page 
  

Calendar Related Tabs 
Calendar Views Menu 

Calendar Activities Bar 

Date Pickers 
(Navigators) 

Tasks Pane 

(Quick) Add Event Pane 

Calendar Grid 

Event Category  
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Advanced Calendar Management 
 

Setting the Calendar View, Continued 
Changing Your 
Calendar View 

The default Calendar display is based on the current Day view.  
Subsequent displays can be toggled by choosing both timeframe and activity 
category.  
 
Displays of Events, Invitations and Tasks are determined by first selecting the 
timeframe. Specific timeframes may also be defined with the Date Picker 
option features. 
 
To change the calendar view: 
Step Action 

1 From the current calendar window, click on the desired timeframe 
view in the calendar views menu: 

 
2 To view specific activity details, click on the desired activity category 

in the calendar views menu: 
 

3 To define a specific date (up to five years from the current date),  
click on the desired timeframe view and select from any of the date 
picker options. 

  
 

 
 

 
Managing Events 

Creating a 
Calendar Event 

The most common calendaring requirement is to create, process and view 
events. There are two ways to designate (create) an event in PAWS: 
 
1. The (Quick) Add Event pane at the bottom of the current calendar window 

allows for the quick creation of events often useful to your own scheduling 
requirements.  

Note: This option adds a new event to a calendar only if you have the 
appropriate read/write access to the selected calendar. 

 
2. The New Event link (icon) generates a comprehensive dialogue of 

additional options used in defining an event that often includes others. 

Continued on the next page 
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Advanced Calendar Management 
 

Managing Events, Continued 
Quick Add 
Event 

To quickly add a personal event to your PAWS calendar: 

Step Action 
1 From the current calendar view, select the desired timeframe to which 

the event will be added. 
2 In the (Quick) Add Event pane, type a descriptor (title) for the event. 
3 If necessary, specify the correct date for the event. 
4 Enter the start time. 

Note: A duration of one hour is automatically designated for the event. 
5 Click on Add Event to create the event. 

The event descriptor appears in the Calendar grid: 

 
 
Create New 
Event 

To add a more detailed event to the PAWS calendar: 

Step Action 
1 From the current calendar view, select the desired timeframe to which 

the event will be added. 
2 From the calendar activities bar, click on the New Event link (icon). 

 

Continued on the next page 
  



PAWS Intermediate: Customization, Advanced E-mail & Calendaring 

20  University of Saskatchewan Training Services 

Advanced Calendar Management 
 

Managing Events, Continued 
 The New Event dialogue is displayed: 

 

 
3 Click on the Section Jump Links to navigate to the option areas. 
4 Complete the event information and click Save to add the event to your 

calendar. 

Continued on the next page 
  

Section Jump Links 

Event Details Section 

Recurrence Section 

Invitees Section 

Reminders Section 
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Advanced Calendar Management 
 

Managing Events, Continued 
Edting a 
Calendar Event 

Once created, calendar entries may be modified or deleted. 

To edit a calendar event:  
Step Action 

1 From the current calendar grid, click on the event descriptor (title). 
The event dialogue is displayed. 

2 Click Edit (bottom of the window). 
The event option fields become available. 

3 Navigating via the section jump links, make changes to the desired 
Event options. 
 

Title: Concise descriptor of the Event 
Event Detail Option Descriptions to Note 

Start/End Time: Use the Calendar icon to ensure correct entry of 
dates 

Availability: Select the checkbox to display busy status for this 
timeframe when others view your availability 

Type: Include an event category description to tag the event for 
more efficient searching functionality 

Privacy: Public – allows everyone to view title, description, time and 
duration of the event. Event details may only be 
viewed with Read permission. 

 Private – Only the date and time is displayed for calculating 
availability status. Uncheck Availability if the event 
is to be completely transparent to others. 

 Show Time and Date Only – Displays no other detail while 
the event timeframe is blocked as busy. 

 
Remember: Send an Email reminder to yourself for events 

requiring lead-time. 
4 Click Save to record the changes and return to the calendar window. 

 
Creating a 
Recurring Event 

To create a recurring event entry: 

Step Action 
1 Select or create the desired event to be repeated. 

Note: For existing events, click the Edit button. 
2 In the Edit Event dialogue, navigate to the Recurrence section. 

 

Continued on the next page 
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Advanced Calendar Management 
 

Managing Events, Continued 
3 Select the desired Frequency timeframe. 

Additional options appear: 

 
4 Complete the desired recurrence pattern. 
5 Click Save to record or update the event and return to the current 

calendar window. 
 
Deleting a 
Calendar Event 

To delete an event: 

Step Action 
1 From the current calendar grid, click the red x icon associated with 

the event entry. 

Note: This icon is only visible if Delete permission has been granted. 
2 At the prompt, click Yes to confirm the deletion. 

 
Searching for 
An Event 

To search for an event or related events: 

Step Action 
1 From any calendar view, in the Search for Events text box, type the 

title or partial description of the event and click Search. 

Events matching the criteria are listed in the Events pane: 

 
2 Order the listed events by clicking on the Start Date or Title headings. 
3 Click on the event title to view details. 

Continued on the next page 
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Advanced Calendar Management, Continued 
 

Managing Events, Continued 
Generating an 
Event Invitation 

To invite one or more users to an event: 

Step Action 
1 Select or create the desired event for which invitations will be sent. 

Note: For existing events, click the Edit button. 
2 In the Edit Event dialogue, navigate to the Invitees section: 

 
3 Type the NSID of the invitee and click Add or select users from an 

existing address book by selecting Add from Address Book. 
4 Repeat steps 3-5 to complete the Invitee List participants. 
5 From the Invitee List, click on Check Availability to review possible 

scheduling conflicts. 
6 From the Invitee List, click on Request RSVP to receive a response 

from the user. 
Note: This option is set by default for all invitations. 

7 Click Save to record or update the event. 
 
Viewing/ 
Responding to 
an Invitation 

The generation of an event invitation automatically records the event 
in the recipient’s calendar and invitations list. Invitations awaiting 
reply are indicated in parentheses beside the invitations link.  
 
To respond to an invitation: 

Step Action 
1 In the PAWS Calendar window, click Invitations in the calendar views 

options bar. 

The invitation list appears in the Invitations pane. 

 
 
Note: Depending on the configuration of your email environment, 

you may also receive an email invitation. Responding to the 
email does not post your response to the calendar. 

Continued on the next page 
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Advanced Calendar Management 
 

Managing Events, Continued 
2 To respond to an invitation, select the desired response by clicking the 

associated radio button: Accept; Decline; Tentative 

Note: When Tentative is selected, the event is not displayed in the 
invitations list. 

3 Click Save to send your response(s). 
4 To email the organizer of the event, click on the name link in the 

Organizer column. 
 

 
Managing Tasks 

 Daily task status is monitored through the current calendar window via the 
Tasks pane display. 

 
 
Viewing Task 
Lists 

To view a detailed task list: 

Step Action 
1 From the current calendar view, select Tasks from the calendar view 

options menu: 
 

The Tasks page is displayed. All tasks appear in the Tasks List Pane. 

 
Continued on the next page 

  

Tasks List Pane 
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Advanced Calendar Management, Continued 
 

Managing Tasks, Continued 
Quick Add Task To quickly create a task:  

Step Action 
1 From the current calendar view, select Tasks from the calendar view 

options menu: 

The Tasks page appears: 

 
2 In the (quick) Add Task pane, enter a Task Title. 
3 If desired, select a Due Date and Time. 
4 Click on Add Task. 

The new entry appears in the Tasks pane: 

 
5 Click on any view to return to the current calendar window.  

 
Create New 
Task 

To add a more detailed Task to the PAWS calendar: 

Step Action 
1 From the current calendar view, select the desired timeframe to which 

the event will be added. 

Continued on the next page 
  

(Quick) Add Task Pane 
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Advanced Calendar Management 
 

Managing Tasks, Continued 
2 From the calendar activities bar, click on the New Task link (icon). 

The New Task window appears: 

 

 
Continued on the next page 

  

Section Jump Links 

Task Details Section 

Recurrence Section 

Reminders Section 
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Advanced Calendar Management 
 

Managing Tasks, Continued 
Editing a Task To edit task information: 

Step Action 
1 In the Tasks pane, click on the Task descriptor (title). 

The Task dialogue appears. 
2 Click the Edit button (bottom of the window). 

The Task option fields become available. 

3 Navigating via the section jump links, make changes to the desired task 
options. 
 

Title: Concise Description of the Task 
Task Option Descriptions to Note 

Start/End Time: Use the Calendar icon to ensure correct entry of 
dates 

Type: Include a category description to tag the task for more 
efficient searching 

Priority: Low –  
 Normal –  
 High –  
Status: Choose a percentage of completion value 
Privacy: Public – those with the appropriate permissions can view all 

event details. 
 Private – Event details are not viewable by others. 
 Show Time and Date Only – Displays no other detail. 
Notes: Maximum 256 characters. 
 
Remember: Send an Email reminder to yourself for tasks requiring 

lead-time. 
4 Press Save to record the changes and return to the calendar window. 

 
Completing a 
Task 

To designate a task as complete: 

Step Action 
1 From the current calendar window Tasks pane area, click the 

checkbox corresponding to the desired task. 
2 Click the Complete button. 

The task title disappears from the Task processing dialogue but 
remains listed in the Tasks activity window for tracking purposes until 
it is deleted. 

Continued on the next page 
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Advanced Calendar Management, Continued 
 

Managing Tasks, Continued 
Deleting a Task To delete a task:  

Step Action 
1 Click the Tasks option in the calendar activities bar, and click the 

Delete button (bottom of the Tasks window). 
or 
If the task is still viewable in the Tasks pane, 
Select the task and click on the Delete button. 

 
Searching for 
Tasks 

To search for a task or related tasks: 

Step Action 
1 From the Tasks view, in the Search for Tasks text box, type the title or 

partial description of the event and click Search. 

Tasks matching the criteria are listed in the Tasks List pane: 

2 Order the listed tasks by clicking on Priority, Title or Due Date 
headings. 

3 Click on the task title to view details. 
 

 
 

Continued on the next page 
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Advanced Calendar Management 
 

Maintaining Calendars 

Displaying/ 
Selecting a 
Calendar 

Multiple calendars may already appear your PAWS Calendars list. If you are 
taking classes or have joined a specialty group, these calendars are also listed. 

To select/display a calendar from the list:  
Step Action 

1 From the current calendar window, display your list of calendars by 
clicking on the Current Calendar: list box arrow:

 
Multiple calendars may appear: 

 

2 Click on any calendar to make it the current calendar view. 
 
Viewing a 
Calendar List 

To view the list of your calendars for management purposes: 

Step Action 
1 From the calendar window, display the Current Calendar: list. 
2 From the Calendar Actions section, select [Manage Calendars...]. 

 
The Manage Calendars view appears: 

 
3 Selecting multiple calendars (by clicking in the associated 

checkboxes), creates a comparison display of the selected calendars. 
Note:  The names of the selected calendars are concatenated to create 

a new calendar in the current calendar dropdown list which is 
only available for the current session. 

Continued on the next page 
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Advanced Calendar Management 

 
Maintaining Calendars, Continued 
Subscribing to a 
Calendar 

Depending on access permission, you can subscribe to other calendars. 

To subscribe to a calendar:  
Step Action 

1 From the calendar window, display the Current Calendar: list. 

The Manage Calendars view is displayed. 

2 Click the Subscribe... option from the Calendars task bar: 

 
The Subscribe to Calendar window appears: 

 
3 In the Search for Calendar text box, specify a key word related to the 

subject/class of calendar 
or  
enter the NSID/name associated with a specific personal calendar. 

4 Click the Search button. 
Calendars meeting the criteria appear: 

 
Note: Sometimes it takes a moment for the calendar display to refresh. 

5 Select the checkbox beside the desired calendar(s) and continue 
searching for other calendars. 

6 When all calendar selections are complete, click on  
Subscribe to Calendar(s). 

7 To view a specific calendar, display the Current Calendar: list and 
select the desired calendar. 

Continued on the next page 
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Advanced Calendar Management 
 

Maintaining Calendars, Continued 
Viewing 
Permissions to a 
Subscribed 
Calendar 

When subscribing to a calendar, the permissions specified by the owner will 
determine access.  
 
Read, delete and modify permissions provide the ability to display, schedule, 
and delete activities in a subscribed calendar. 
 

 To view the granted permissions for a subscribed calendar: 
Step Action 

1 From the Calendar window, display the Current Calendar list and 
select [Manage Calendars...]. 
The Manage Calendars view appears. 
Note: There are five columns (categories) of information displayed 

for each calendar: 

 
Note: Calendars with at least some modification access will display 

Edit in the Properties column. 
2 In the Subscribed Calendars section, navigate to the calendar for which 

the desired permissions are to be displayed. 
 

Continued on the next page 
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Advanced Calendar Management, Continued 
 

Maintaining Calendars, Continued 
3 In the Properties column, click on Edit. 

The Edit Calendar dialogue appears: 

 
 
Note: This window does not allow edits. 

4 Navigate to the Share This Calendar section to view public 
permissions.  
If you have been given personal permissions, navigate to the Share 
This Calendar With Specific Users section: 

 
 
Unsubscribing 
to a Calendar 

To unsubscribe from a calendar: 
 
Step Action 

1 Display the Current Calendar: list and select [Manage Calendars...] 
2 Navigate to the calendar to be removed. 
3 In the Action column for the calendar, click on the Unsubscribe 

Calendar link. 

The calendar is removed from the list. 

Continued on the next page 
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Advanced Calendar Management 
 

Maintaining Calendars, Continued 
Creating a New 
Calendar 

If you are in charge of group projects or need to keep track of scheduled 
resources, you can create a new calendar complete with multi-user access 
permissions. 
To create a new calendar: 
Step Action 

1 From the Current Calendar: list box display, select  
[Manage Calendars...]: 
The Manage Calendars window is displayed. 

2 Click the New Calendar… option from the Calendars task bar: 

 
The New Calendar dialogue appears: 

 
3 Type a Calendar Name in the Calendar Name: text box. 
4 In the Display Name: text box, type the viewing name for the calendar.  
5 In the Description: text box, enter the purpose of the calendar.  

Note: This information assists in determining the benefit of 
subscribing to the calendar. 

6 Select the Availability checkbox if this calendar is a consideration in 
determining free time. 

7 Click Save to create the calendar. 
8 To view this calendar, select it from the Current Calendar: list. 

Continued on the next page 
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Advanced Calendar Management 
 

Maintaining Calendars, Continued 
Setting 
Calendar 
Properties 

Continue to specify public accessibility, individual user permissions, time 
zones and ownership through the Edit Calendar dialogue. 

 To set the properties for a calendar: 
Step Action 

1 From the Current Calendar: list box display, select 
[Manage Calendars...]. 
The Manage Calendars window is displayed. 

2 Under the Properties column in the Calendars pane, click on the Edit 
link of the desired calendar. 

 
The Edit Calendar dialogue appears: 

 
 
The Edit Calendar dialogue is divided into sections displayed by 
scrolling or clicking the section jump links at the top of the window: 
 

 
Continued on the next page 
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Advanced Calendar Management 
 

Maintaining Calendars, Continued 
Viewing/Editing 
General 
Information 

To view/edit general information for a specific calendar: 

Step Action 
1 From the top of the Edit Calendar dialogue, click on the General 

Information link. 

The public access section is displayed: 

 
2 Make the desired changes and click the Save button at the bottom of 

the window. 
 
Setting Public 
Access 

To set public access permissions: 

Step Action 
1 From the top of the Edit Calendar dialogue, click on Share This 

Calendar link. 

The public access section appears: 

 
2 Select the desired access by clicking the associated checkboxes. 
3 Make the desired changes and click Save. 

 
Setting 
Individual 
Permissions 

To set specific user permissions: 

Step Action 
1 From the top of the Edit Calendar dialogue, click on the Share This 

Calendar With Specific Users link. 

The individual permissions list is displayed: 

 
2 Type the NSID of a specific user and click Add  

or click Add from Address book to select from an Address Book. 

Continued on the next page 
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Advanced Calendar Management 
 

Maintaining Calendars, Continued 
Step Action 

 Selected users appear in the Permissions List: 

 
3 Designate permissions by clicking the corresponding checkbox for 

each desired attribute. 
4 To remove a user, click on the checkbox in front of the user name. 
5 Make the desired changes and click the Save button at the bottom of 

the window. 
 
Specifying 
another Owner 

Ownership of your calendar may be transferred to or shared with another. 
Owners have the same functional capabilities as the creator. 
To view/edit Owner information for a calendar: 
Step Action 

1 From the top of the Edit Calendar dialogue, click on the Owners link. 

The Owners section of the Edit Calendar appears: 

 
2 Type the NSID of the user and click Add 

or  
Click Add from Address book to search for and select an owner. 

3 Make the desired changes and click Save. 
 
Creating a 
Calendar Group 

Calendars may be combined for comparison, and for greater control over 
scheduling /managing your time. The ability to layer related calendars into a 
single view is referred to as Calendar grouping. 

 To create a calendar group: 
Step Action 

1 From the Current Calendar: list box display, select 
[Manage Calendars...]. 
The Manage Calendars window is displayed. 

Continued on the next page 
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Advanced Calendar Management, Continued 
 

Maintaining Calendars, Continued 
2 Click the New Calendar Group… option from the Calendars task bar: 

 
The New Calendar dialogue appears. 

 
4 Enter a Group Name (spaces allowed) and brief description for the 

Calendar Group. 
5 Add a Member to the group by: 

Typing a calendar ID and clicking Add. 
or 
Clicking Search for Calendar to locate and select the desired 
calendar. 

 
6 To select members from your personal or subscribed calendar list, 

Display the Quick Add Personal or Subscribed Calendar list and 
select the desired calendar. 

 
7 To remove a calendar from the set, select the calendar name and click 

Remove. 

Continued on the next page 
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Advanced Calendar Management, Continued 
 

Maintaining Calendars, Continued 
8 With the member list complete, click Save. 

The new grouped Calendar appears in the Calendar Groups section of 
the Calendars pane: 

 
 
Editing A 
Calendar Group 

To edit a calendar group: 

Step Action 
1 From the Current Calendar: list box display, select 

[Manage Calendars...]. 
The Manage Calendars window is displayed. 

2 Click on the Edit link in the same row as the desired calendar group.  
3 Make the required changes and click Save. 

 
Adding an 
Event to a 
Calendar Group 

To add an event to a calendar group: 
 

Step Action 
1 From the Current Calendar: display list, select a calendar group. 

The Group Calendar is displayed. 

2 Click the New Event link (icon). 
3 Specify the event specifics and click Save. 

The event is recorded for all calendars in the Calendar Group. 

 

Continued on the next page 
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Advanced Calendar Management 
 

Customizing the Calendar Environment 

 The PAWS calendar is configurable in a variety of ways through the Options 
tab. This section identifies some customizations that can make calendaring 
processing more efficient. 
 
Configurable options are divided into three Options View menu categories: 
Global used to set language, time zone, and date display preferences 
Calendar used to set the default calendar options 
Address Book used to set personal address book details 
 
By default, the Options - Calendar dialogue appears: 
 

 

 
 

Continued on the next page 
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Advanced Calendar Management, Continued 
 

Customizing the Calendar Environment, Continued 
Setting 
Calendar 
Defaults 

To change or set the default operation for your calendaring needs: 

Step Action 
1 From the current calendar display, click the Options tab. 

By default, the Options - Calendar dialogue is displayed. 

Default Calendar View: Choose from Day, Week, Month 
Calendar Options to Note: 

Default Type:  Category assigned to events and tasks for searching 
and filtering purposes. 

Always show completed tasks whenever tasks are shown: 
Includes completed tasks in the Tasks List Display 

Default event status filter: Determines which events to display 
Send an email reminder message for all events and tasks:  
 Specify any or all of your email addresses 
Send notification whenever somebody invites me to an event: 
 Enter your preferred email address 

2 Complete the default settings and click Save to update the changes. 
 
Setting Global 
Defaults 

To set preferences for the overall operation of both calendar and address book: 

Step Action 
1 From the current calendar display, click the Options tab. 
2 From the Options View tabs, click the Global link. 

The Options – Global Settings dialogue appears: 

 

 
Continued on the next page 
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Advanced Calendar Management, Continued 
 

Customizing the Calendar Environment, Continued 
 
Step Action 

2 Set desired preferences for Language, Date Display and Time Zone 
and click Save to update the changes. 

 
Setting Address 
Book Defaults 

To set personal address book display preferences 
 
Step Action 

1 From the current calendar display, click the Options tab. 
2 From the Options View tabs, click the Global link. 

The Options – Address Book dialogue appears: 

 

 

Default View: Select from Luminous Address Book or Corporate 
Directory 

Address Book Options To Note: 

Columns to Display:  
Customize up to six categories of information to be displayed per 
contact from the following list: 

Display Name, Company, Title, Phone (Primary Phone, Work Phone, Home Phone, 
FAX Phone, Pager Phone) ,Email (Primary Email, Work Email, Home Email) 
,Address (Home Address, Work Address), Web Page Address 1, Web Page Address 
2, Calendar Address, Availability Address, Dates (Birthday, Anniversary 
Date),Organization Unit, Contact Actions (Edit link, View Calendar Icon).  

3 Set the desired preferences and click Save to update the changes. 
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